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ΑΠΟΣΠΑΣΜΑ 

 
Στη παρούσα διπλωματική εργασία γίνεται μία προσπάθεια ανάλυσης της 
ορατότητας του οδικού για το νησί της Χίου. 
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1 ΧΡΗΣΙΜΟΤΗΤΑ ΑΝΑΛΥΣΗΣ ΟΡΑΤΟΤΗΤΑΣ 
 
 

1.1 Εισαγωγή 
 
 
 
Στην παρούσα διπλωματική εργασία θα αναλύσουμε την ορατότητα του οδικού 
δικτύου της Χίου. Θα γίνει η ανάλυση για όλη την Χίο και έπειτα για μεγάλους 
οικισμούς άνω των 1.000 κατοίκων. Το πρόγραμμα που χρησιμοποιήθηκε για την 
δημιουργία των χαρτών είναι το ARCGIS και τα δεδομένα είναι το DEM το οδικό 
δίκτυο και οι οικισμοί της Ν. Χίου. Το ψηφιακό μοντέλο εδάφους ήταν 30 μέτρα, 
στο οποίο έγινε αφαίρεση θορύβου για να ομαλοποιηθεί και να μην υπάρχουν 
λάθος τιμές (αν και είναι δύσκολο σε τέτοιο DEM) που μπορεί να είναι σε κάποια 
σημεία παράλογα χαμηλές ή υψηλές. Το οδικό δίκτυο χωρίστηκε σε 4 κατηγορίες. 
Οι οικισμοί από πολυγωνικό αρχείο , έγιναν σημειακό. Με όλα τα παραπάνω 
προχωρήσαμε στην ανάλυση ορατότητας και θα αναλύσουμε εκτενέστερα πως 
δημιουργήθηκαν αυτοί οι χάρτες που θα παρουσιαστούν παρακάτω. 
 

 
 
 

1.2 Περιοχή Μελέτης 
 
 
 
 

Η Χίος είναι νησί του Κεντρικού Αιγαίου και το πέμπτο μεγαλύτερο της Ελλάδας με 
έκταση 842 km2 και μήκος ακτών 213 km. Διοικητικά αποτελεί την Περιφερειακή 
Ενότητα Χίου που ανήκει στην Περιφέρεια Βορείου Αιγαίου μαζί με τα Ψαρά, τα 
Αντίψαρα και τις Οινούσσες. 
 
Ο πληθυσμός ανέρχεται σε 51.320 κατοίκους (απογραφή 2011) που ζει στην πόλη 
της Χίου, πρωτεύουσα και κύριο λιμάνι του νησιού, καθώς και στα 64 χωριά του 
νησιού. Η μικρότερη απόσταση του νησιού από τις απέναντι ακτές της Μικράς 
Ασίας, είναι 3,5 ναυτικά μίλια από το ακρωτήριο Πούντα ως τη χερσόνησο της 
Ερυθραίας, στο ύψος του Τσεσμέ. 
 
Τα κύρια προϊόντα που εξάγει είναι η ονομαστή χιώτικη μαστίχα, το λάδι, τα σύκα 
και το κρασί, ενώ έχει διεθνή φήμη για το μέγεθος και την ποιότητα της ναυτιλίας 
της. Η πρωτεύουσα του νησιού, η πόλη της Χίου, λέγεται και Χώρα. 
 
 
 



Σελίδα 6 από 38 Πρίνος Πέτρος  © 
 

 
 

1.3 Ανάλυση Ορατότητας 
 

Η λογική της ανάλυσης ορατότητας πηγάζει από την ανάγκη να μελετήσουμε το 
τοπίο και πιο συγκεκριμένα το ορατό τοπίο σε μια τουριστική κατά βάση περιοχή. Η 
παρατήρηση του τοπίου περιλαμβάνει πολλές παραμέτρους όπως η οικολογία, η 
γεωμορφολογία, η γεωγραφία και φυσικά η ανθρώπινη παρέμβαση. Το τοπίο 
λοιπόν συνήθως είναι το αποτέλεσμα της επίδρασης του ανθρώπου στο φυσικό 
περιβάλλον καθώς δεν υπάρχουν πλέον πολλά παρθένα τοπία. Ανθρωπογενής 
επεμβάσεις επηρεάζουν πολύ την αισθητική του τοπίου και σε περιοχές όπως τα 
μικρά ελληνικά νησιά οι παρεμβάσεις αυτές επηρεάζουν την εικόνα του νησιού. Το 
Συμβούλιο της Ευρώπης αναγνώρισε τη σημαντικότητα του τοπίου για την ποιότητα 
της ζωής των ανθρώπων εντός και εκτός πόλεων και στο πλαίσιο αυτό έχει  
υπογραφεί η Ευρωπαϊκή Σύμβαση για το Τοπίο (ELC) το 2000 
συμπεριλαμβανομένου και της Ελλάδας. 
Ο τουρισμός ως οικονομική και κοινωνική πρακτική σχετίζεται με τα τοπία και την 
εκτίμησή τους με πολλούς τρόπους. Οι τουρίστες αναζητούν, για παράδειγμα, 
«εικονικά», «δημοφιλή», «χαλαρωτικά» τοπία και σχεδιάζουν ταξίδια και διακοπές 
ανάλογα με τα πραγματικά ή φανταστικά τοπία, κυρίως στις εναλλακτικές τους 
μορφές. Το επονομαζόμενο «τουριστικό βλέμμα» έχει διαμορφώσει πολλά τοπία 
και θεωρείται πολύ σημαντικό στους τουριστικούς προορισμούς (Urry, 1996, Urry & 
Larrsen, 2011). Τι βλέπουν οι τουρίστες σε έναν προορισμό και πώς αυτό σχετίζεται 
με τις προσδοκίες τους (πραγματικές ή φανταστικές) και αυτό που θεωρούν 
«όμορφο» ή «ανεκτό» είναι μια κρίσιμη παράμετρος. Με αυτή την έννοια, αυτό που 
είναι ορατό σε έναν τουριστικό προορισμό μπορεί να είναι πολύ σημαντικό για την 
τουριστική βιομηχανία και μπορεί να διαμορφώσει την οικονομική τύχη του 
προορισμού. 
Παρόλο που ίσως είμαστε πολύ συγκεκριμένοι για το τι θέλουμε και τι δεν κάνουμε, 
τι θέλουμε να δούμε και τι δεν κάνουμε, λίγοι άνθρωποι βασίζουν όλες τις 
αποφάσεις τους και τις συμπεριφορές τους αποκλειστικά σε αυτό. Στην 
πραγματικότητα, οι περισσότεροι άνθρωποι τείνουν να αγνοούν τα αξιοθέατα και 
τα ζητήματα που μπορεί να τους ενοχλούν ή να τα ενοχλούν. Αυτό ισχύει ασφαλώς 
για τους τουρίστες. Παρόλο που πολλοί τουρίστες βλέπουν καθαρά τοπία, 
αξιοθέατα και κτίρια που δεν τους αρέσουν, αυτά μπορεί να επισκιάζονται από 
άλλες πτυχές της εμφάνισης ενός προορισμού. Αυτό, φυσικά, δεν σημαίνει ότι είναι 
πρόθυμοι να συγχωρήσουν τα πάντα, ειδικά τώρα που η δύναμη των εικόνων, των 
απόψεων και των τοπίων αυξάνεται λόγω της αυξανόμενης σημασίας των 
κοινωνικών μέσων ενημέρωσης και της ικανότητας των τουριστών να απεικονίζουν 
τι κάνουν δεν το αρέσει και το μοιράζεστε με τον υπόλοιπο κόσμο. 
Αυτό αυξάνει τη σημασία του ορατού και την ανάγκη να σχεδιάσουμε προσεκτικά 
τις χρήσεις γης που δεν είναι δημοφιλείς, «άσχημες» ή απλά δεν συμμορφώνονται 
με αυτό που οι τουρίστες αναμένουν να δουν και να βιώσουν. 
Ο τουρισμός είναι πολύ σημαντικός για τα νησιά οικονομικά, κοινωνικά και 
συμβολικά και έχει επίσης σημαντικό αντίκτυπο στα αναπτυξιακά ζητήματα. Ο 
τουρισμός είναι μια από τις σημαντικότερες δραστηριότητες για την οικονομία των 
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νησιών, όσον αφορά την απασχόληση και το εισόδημα. Έχει επίσης σημαντική 
επίδραση στις τοπικές κοινωνίες, στον τρόπο και στην ποιότητα ζωής (Τσιλιμίγκας ) 
 
 

1.4 Τουρισμός 
 

Για  την  ελληνική  οικονομία και ιδιαίτερα για τα ελληνικά νησιά,  ο  τουρισμός  
αποτελεί  κεντρικό  πυλώνα  ανάπτυξης  με  σημαντική συνεισφορά στην 
απασχόληση και στις επενδύσεις. Η πλούσια πολιτιστική κληρονομιά, η εκτεταμένη 
ακτογραμμή και το φυσικό περιβάλλον είναι ορισμένα από τα συγκριτικά  
πλεονεκτήματα  που  καθιστούν  την Ελλάδα  από  τους  σημαντικότερους  
τουριστικούς προορισμούς  παγκοσμίως.  Ταυτόχρονα,  ο  τουρισμός  είναι 
εξωστρεφείς  τομείς  της  ελληνικής  οικονομίας,  με  την  εισροή  ταξιδιωτικού  
συναλλάγματος  να επιδρά θετικά στο ισοζύγιο πληρωμών της χώρας, 
συμβάλλοντας στη μείωση του ελλείμματος των τρεχουσών συναλλαγών (ΙΟΒΕ, 
2012) 
 
Σήμερα,  η  κρίση  την  οποία  διέρχεται  η  ελληνική  οικονομία  υποδεικνύει  την  
αναγκαιότητα υιοθέτησης δράσεων στην κατεύθυνση προσαρμογής σε ένα νέο 
αναπτυξιακό πρότυπο. Αποτελεί κοινή  διαπίστωση  ότι  το  πρότυπο  αυτό  θα  
πρέπει  να  δίνει  έμφαση  στην  αξιοποίηση  των πλεονεκτημάτων  της  χώρας  και  
στην  τόνωση  της  εξωστρέφειας  και  των  επενδύσεων.  Το ενδιαφέρον  της  
αναπτυξιακής  προοπτικής  της  ελληνικής  οικονομίας  από  την  πλευρά  των 
πολιτικών  και  εργαλείων  τόνωσης  της  εξωστρέφειας,  στρέφεται  εύλογα  στις  
στρατηγικές ανάπτυξης  των  εξαγωγών  προϊόντων  και  υπηρεσιών,  όπως  και  
στον  τομέα  του  τουρισμού,  ο οποίος καλείται να διαδραματίσει περισσότερο 
ενεργό ρόλο στην οικονομική ανάπτυξη της χώρας, μέσα  σε  ένα  ιδιαίτερα  
ανταγωνιστικό  περιβάλλον  από τις  χώρες  της  Μεσογείου,  αλλά  και  από νέους 
αναδυόμενους προορισμούς. 
 
Το 2017η Ελλάδα υποδέχθηκε σχεδόν 27,2εκ. τουρίστες και εισέπραξε σχεδόν 
€14,2δισ. Η εικόνα για το 2017 αναφορικά με την επιλογή  του μεταφορικού μέσου 
των τουριστών που επιλέγουν την Ελλάδα για τις διακοπές τους είναι σχεδόν ίδια με 
τα προηγούμενα χρόνια. Συγκεκριμένα, οι αεροπορικές αφίξεις αποτέλεσαν το 66% 
του συνόλου των αφίξεων ακολουθούμενες από τις οδικές με 30,0% και τις 
θαλάσσιες με 4%. Το ποσοστό των τουριστών που επέλεξαν το τρένο ως μέσο 
μεταφοράς για το ταξίδι τους στην Ελλάδα ήταν αμελητέο. Αναφορικά με τα έσοδα, 
παρατηρείται έντονη εποχικότητα, με το 61,0% των εσόδων να καταγράφεται στο 3ο 
τρίμηνο του έτους. Αντίστοιχα, στο 2ο τρίμηνο του έτους που σηματοδοτεί την 
έναρξη την έναρξη της τουριστικής περιόδου καταγράφεται το 24,0%των εσόδων.  
 
Σύμφωνα με το ΙΟΒΕ (2012), κάθε 1€ που δημιουργεί τουριστική δραστηριότητα, 
δημιουργεί έμμεση και προκαλούμενη πρόσθετη οικονομική δραστηριότητα 1,2€ 
και άρα, συνολικά, δημιουργεί 2,2€ ΑΕΠ. Δηλαδή, ο πολλαπλασιαστής της 
τουριστικής δραστηριότητας ανέρχεται σε 2,2 (ΣΕΤΕ, 2018). 
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Από τα παραπάνω καταλαβαίνουμε τη σημαντικότητα του τουρισμού στην ελληνική 
και ιδίως στη νησιωτική οικονομία. Η συνεισφορά των μελετών ορατότητας θα 
βοηθήσει στην οπτικοποίηση ενός προορισμού σε μια εποχή όπου η εικόνα μέσα 
από το Internet και τα κοινωνικά δίκτυα παίζει το πρώτο λόγο για τον χαρακτηρισμό 
της περιοχής και κα επέκταση τη πιθανή επίσκεψή του. 
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2 ΜΕΘΟΔΟΛΟΓΙΑ 
 
Σε αυτό το κεφάλαιο θα αναλυθεί η μεθοδολογία εργασίας τα πρωτογενή δεδομένα 
καθώς και τα λογισμικά που χρησιμοποιήσαμε.  
 

2.1 Λογισμικά – Εργαλεία 
 

Για την επεξεργασία και ανάλυση των δεδομένων στην παρούσας διπλωματικής 
χρησιμοποιήθηκαν τα Συστήματα Γεωγραφικών Πληροφορικών (ΣΓΠ) και πιο 
συγκεκριμένα το λογισμικό ArcGIS της ESRI (https://www.esri.com/en-
us/arcgis/about-arcgis/overview).  
Τα ΣΓΠ είναι σύστημα καταγραφής, αποθήκευσης, ανάλυσης, οπτικοποίησης και 
διαχείρισης χωρικών δεδομένων. Βασικό χαρακτηριστικό των ΣΓΠ είναι η 
διασύνδεση των χωρικών πληροφοριών με περιγραφικές. Η δυνατότητα αυτή είναι 
και το βασικό σημείο διαφοροποίησης των ΣΓΠ με τα CAD.  
 

2.1.1 Το ArcGIS 
 
Το λογισμικό ArcGIS θεωρείτε από τα πιο πλήρη συστήματα ΣΓΠ και περιλαμβάνει 
πληθώρα εργαλείων για κάθε χρήση. Στα πλαίσια της παρούσα διπλωματικής 
χρησιμοποιήθηκε το ArcGIS Desktop 10.5. Η άδεια ήταν επιπέδου Advanced 
(ArcInfo) και περιλάμβανε και άδεια για το Extension Spatial Analyst. 
 
 

2.2 Πρωτογενή Δεδομένα 
 
Για την ανάλυση της ορατότητας του οδικού δικτύου από τους οικισμούς θα 
χρειαστούμε αρχικά το οδικό δίκτυο και τους οικισμούς της περιοχής μελέτης. Για 
να μπορούν όμως να συγκριθούμε μεταξύ τους χρειαζόμαστε και τις υψομετρικές 
διαφορές τους καθώς και τυχών ορεινούς όγκους που θα μεσολαβούν. Το κενό αυτό 
καλύπτεται από το Ψηφιακό Μοντέλο Εδάφους. Όλα τα δεδομένα μας θα πρέπει να 
είναι σε κοινό προβολικό σύστημα και στα πλαίσια της παρούσας διπλωματικής 
χρησιμοποιήθηκε το Ελληνικό Γεωδαιτικό Σύστημα Αναφορά του 1987 (ΕΓΣΑ 87). Η 
Ορθότητα των δεδομένων ήταν δεδομένη καθώς αυτά προέχονται από παλαιότερες 
εργασίες του ιδίου ή από έγκυρες διεθνής πηγές. 
 

2.2.1 Ψηφιακό Μοντέλο Εφάδους (DEM) 
 
To Ψηφιακό Μοντέλο Εδάφους (Digital Elevation Model – DEM) είναι ψηφιδωτό 
αρχείο (raster) όπου ή τιμή της κάθε ψηφίδα αντιστοιχεί σε υψόμετρο. 
Στην αρχή δοκιμάσαμε το DEM του Κέντρου Έρευνας για τη Παρατήρηση της Γης 
(Earth Observation Research Center https://www.eorc.jaxa.jp/en/) του Ιαπωνικού 
Οργανισμού Ερευνών Αεροδιαστημικής (Japan Aerospace Exploration Agency) 

https://www.esri.com/en-us/arcgis/about-arcgis/overview
https://www.esri.com/en-us/arcgis/about-arcgis/overview
https://www.eorc.jaxa.jp/en/
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Το παρόν DEM δημιουργήθηκε από της λήψεις του δορυφόρου Advanced Land 
Observing Satellite "DAICHI" (ALOS) και το προϊόν ονομάζεται "ALOS World 3D - 30m 
(AW3D30)". Η διακριτική ικανότητα των λήψεων είναι 30μ. Αυτό σημαίνει ότι κάθε 
pixel  του raster αντιστοιχεί στη γη σε μία επιφάνεια 30 επί 30 μέτρα. 
https://www.eorc.jaxa.jp/ALOS/en/aw3d/index_e.htm.  
 
Το download των δεδομένων γίνεται από την ιστοσελίδα του Earth Observation 
Research Center https://www.eorc.jaxa.jp/ALOS/en/aw3d30/index.htm  
 
Μετά δοκιμάσαμε το DEM του ιδίου από παλαιότερη εργασία από το προπτυχιακό 
πρόγραμμα σπουδών. Δεν υπήρχε διαφορά στην ποιότητα της πληροφορίας καθώς 
και τα δύο (2) είναι διακριτικής ικανότητας 30μ. Τελικά χρησιμοποιήθηκε το DEM 
του ιδίου καθώς συμβάδιζε με τα υπόλοιπα δεδομένα και έτσι αποφεύχθηκε έξτρα 
εργασία ομοιογενοποίησης των δεδομένων. 
 
Επεξεργασία  
Τo DEM λαμβάνεται από το internet σε κομμάτια. Αρχικά λαμβάνουμε όλα τα 
κομμάτια που αφορούν τη περιοχή μελέτης μας και μετά πρέπει να τα ενώσουμε 
ώστε να γίνει ένα αρχείο. Η Εργασία μπορεί να γίνει μέσα από το ArcGIS με το 
εργαλείο Mosaic to New Raster του ArcToolbox (ArcToolbox > Data Management 
Tools > Raster > Raster Dataset > Mosaic To New Raster) 
 
Ακολουθεί το «κόψιμο» στα όρια της ακτογραμμής καθώς δεν χρειαζόμαστε τα 
υψόμετρα στη θάλασσα. Το κόψιμο γίνεται με το εργαλείο clip (ArcToolbox > Data 
Management Tools > Raster > Raster Processing > Clip) 
 
Αφαίρεση θορύβου. 
Κάποιες φορές τα DEM περιέχουν θόρυβο δηλαδή κάποια κελιά έχουν λάθος τιμή 
από σφάλματα κατά τη δειγματοληψία. Ο θόρυβος αυτός μπορεί να προκαλέσει 
«τρύπες» στην ανάλυση ορατότητας που θα εφαρμόσουμε αργότερα. Μπορεί να 
αφαιρεθεί επαναυπολογίζοντας τη τιμή του κάθε κελιού βάση της μέσης τιμής των 
γύρο κελιών του. Το αποτέλεσμα είναι ένα πιο στρωτό DEM χωρίς απότομες 
μεταβολές στις τιμές. Χρησιμοποιήσαμε το εργαλείο Focal Statistics και τη μέθοδο 
Mean του extension Spatial Analyst (ArcToolbox > Spatial Analyst Tools > 
Neighborhood > Focal Statistics) και ομαλοποιήσαμε το DEM που θα 
χρησιμοποιήσουμε.  
 

2.2.2 Οδικό Δίκτυο 
 
Το οδικό δίκτυο που χρησιμοποιήσαμε σε αυτή τη διπλωματική προέρχεται από 
παλαιότερες εργασίες του ιδίου που εκπόνησε στα πλαίσια του μεταπτυχιακού του. 
Είναι γραμμικής γεωμετρίας δηλαδή οι δρόμοι αποτυπώνονται σα γραμμές (χωρίς 
πλάτος) όπου έχουμε απλά τη πληροφορία του μήκους και της απόστασης. Επίσης 
είναι κατηγοριοποιημένο σε τέσσερις κατηγορίες δρόμων: 

 Άσφαλτος 

 Χωμάτινοι βατοί 

https://www.eorc.jaxa.jp/ALOS/en/aw3d/index_e.htm
https://www.eorc.jaxa.jp/ALOS/en/aw3d30/index.htm
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 Χωμάτινοι αγροτικοί 

 Χωμάτινοι δασικοί  
Το συνολικό μήκος του οδικού του νησιού είναι περίπου 2.665 km. Από αυτά η κάθε 
κατηγορία καταλαμβάνει: 
 

Κατηγορία δρόμου Μήκος (km) Ποσοστό (%) 

Άσφαλτος 604 22,66 

Χωμάτινοι βατοί 767 28,78 

Χωμάτινοι αγροτικοί 1.034 38,80 

Χωμάτινοι δασικοί 260 9,76 

Σύνολο 2.665 100 
Πίνακας 1: Κατηγορίες οδικού δικτύου 
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Χάρτης 1: Κατηγοριοποιημένο οδικό δίκτυο Χίου 
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2.2.3 Οικισμοί 
 
Το αρχείο των οικισμών που χρησιμοποιήσαμε προέρχεται και αυτό από 
παλαιότερες εργασίες του ιδίου στα πλαίσια του μεταπτυχιακού προγράμματος 
σπουδών. Το αρχείο περιλαμβάνει 79 οικισμούς και στη περιγραφική πληροφορία 
περιλαμβάνεται και η απογραφή του πληθυσμού του 2001. Το παρόν αρχείο είναι 
πολυγωνικής γεωμετρίας δηλαδή κάθε οικισμός απεικονίζεται ως πολύγωνο με τα 
όρια του πολυγώνου υποδεικνύουν τα όριο των οικισμών. 
 
Επεξεργασία 
 
Όπως προαναφέρθηκε το αρχείο των οικισμών είναι πολυγωνικής γεωμετρίας. Η 
ανάλυση ορατότητας εφαρμόζεται από σημεία οπότε θα πρέπει να μετατραπούν τα 
πολύγωνα σε σημεία. Για τη μετατροπή του πολυγωνικού αρχείου σε σημειακό 
χρησιμοποιήσαμε το εργαλείο Feature to Point (ArcToolbox > Data Management 
Tools > Features > Feature to Point). Το σημείο που προκύπτει είναι στο κέντρο 
βάρος (centroid) του πολυγώνου. 
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Χάρτης 2: Όρια και κέντρο βάρους οικισμών Χίου 
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2.3 Μεθοδολογία 
 

2.3.1 Ανάλυση Ορατότητας – Visibility  
 
Η ανάλυση ορατότητας μέσα από το λογισμικό ArcGIS γίνεται με το εργαλείο Visibility 

(ArcToolbox > Spatial Analyst Tools > Surface > Visibility). To visibility ελέγχει ποια 
κελιά ενός raster αρχείου (το DEM στη δική μας περίπτωση) είναι ορατά από ένα 
σύνολο σημείων (το αρχείο των οικισμών για εμάς). Ο αλγόριθμος τοποθετεί τα 
σημεία στο ύψους του κελιού που βρίσκονται και να ελέγχει αν υπάρχει ευθεία 
επαφή με ένα ένα όλα τα κελιά του raster μας. Αν μεσολαβεί εμπόδιο τότε το κελί 
βαφτίζεται μη ορατό. 
 
Από τα παραπάνω καταλαβαίνουμε ότι το αποτέλεσμα που παίρνουμε είναι ένα 
raster αρχείου που μας δείχνει την ορατότητα του κάθε κελιού από το σύνολο των 
σημείων που του δώσαμε. Τώρα πρέπει αυτή η πληροφορία να περάσει στο οδικό 
δίκτυο. Το πρώτο βήμα είναι η διανησματοποίηση (vectror) του raster αρχείου που 
έχουμε. Για να γίνει αυτό χρησιμοποιούμε το εργαλείο Raster to Polygon 
(ArcToolbox > Conversion Tools > From Raster > Raster to Polygon) που μετατρέπει 
τα κελιά σε πολύγωνα και ταυτόχρονα συγχωνεύει αυτά με την ίδια ιδιότητα – τιμή 
(dissolve). To Αποτέλεσμα είναι ένα πολυγωνικό vector αρχείο με μεγάλα πολύγωνα 
όπου η τιμή της περιγραφικής πληροφορίας του πολυγώνου αναφέρεται στη 
ορατότητα ή μη του πολυγώνου αυτού. 
 
Το τελευταίο βήμα αφορά στην εισαγωγή της περιγραφικής πληροφορίας των 
πολυγώνων στα γραμμικά τμήματα του οδικού. Αυτό περιλαμβάνει δύο ενέργειες. 
Η πρώτη αφορά την κοπή των δρόμων στα όρια των πολυγώνων κα η δεύτερη στην 
εισαγωγή της περιγραφικής πληροφορίας από το πολυγωνικό στο γραμμικό με 
βάση την επικάλυψη. Η διαδικασία αυτή υπάρχει έτοιμη στο ArcGIS και είναι το 
εργαλείο Intersect (ArcToolbox > Analysis Tools > Overlay > Intersect). Με την 
εφαρμογή του παραπάνω παίρνουμε πλέον ένα οδικό δίκτυο κατακερματισμένο 
βάση την ορατότητάς του από τα σημεία αναφοράς που ορίσαμε. 
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3 ΑΠΟΤΕΛΕΣΜΑΤΑ 
 
 
 
Για την ανάλυση της ορατότητας θα τρέξουμε έξι (6) σενάρια. Στο πρώτο θα γίνει 
έλεγχος από όλους τους οικισμούς και στα υπόλοιπα πέντε (5) θα γίνει έλεγχος 
πάνω σε έναν οικισμό. Το κριτήριο επιλογής των οικισμών καθώς και του αριθμού 
αυτών ήταν όσοι διαθέτουν άνω των 1.000 κατοίκων. Τα σενάρια που αναλύθηκαν: 
 

1. Όλοι οι οικισμοί 

2. Χίος 

3. Βροντάδος 

4. Θυμιανά 

5. Πυργί 

6. Νένητα 

7. Βολισσός  
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3.1 Όλοι οι οικισμοί 

 
Χάρτης 3: Ορατότητα Οδικού από όλους τους Οικισμούς 
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Σε αυτό το σενάριο όπου χρησιμοποιήθηκαν όλοι οι οικισμοί εντοπίστηκαν 1.115 
km οδικού  να είναι ορατά από τους οικισμούς. Αυτό σημαίνει ότι σχεδόν το 42% 
του οδικού είναι ορατό από κάποιο οικισμοί. Όπως ήταν αναμενόμενο το 
μεγαλύτερο μέρος του ορατού οδικού συσσωρεύεται στο Νοτιοανατολικό τμήμα 
του νησιού όπου συναντώνται αρκετοί από τους οικισμούς του νησιού καθώς και 
πολύ μεγάλο μέρος του πληθυσμού. H ορατότητα του οδικού ανά κατηγορία 
παρουσιάζεται στον παρακάτω πίνακα. 
 
 
 

Κατηγορίες Οδικού Ορατό δίκτυο (km) Μη ορατό δίκτυο (km) 

Άσφαλτος 300 304 

Χωμάτινοι βατοί 275 492 

Χωμάτινοι αγροτικοί 427 607 

Χωμάτινοι δασικοί 113 147 

Σύνολο 1.115 1.550 
Πίνακας 2: Κατανομή ορατότητας ανά κατηγορία οδικού στο σύνολο των οικισμών 

 
 
Η κατανομή της ορατότητας ανά κατηγορία δρόμου τυχαίνει και είναι περίπου στη 
μέση. Χαρακτηριστικά τα 300 από τα 604 km ασφάλτινου δρόμου είναι ορατά από 
τους οικισμούς. Στο σύνολο όπως προαναφέρθηκε μόνο το 42% του οδικού είναι 
ορατό. Το ποσοστό αυτό αν και μικρό είναι αναμενόμενο. Η Χίος σα νησί έχει 
έκταση 842 km2 και 51.320 κατοίκους (απογραφή 2011). Μεγάλο μέρος του 
πληθυσμού κατοικεί στο νοτιοανατολικό τμήμα και το μεγαλύτερο μέρος του 
οδικού διασχίζει το νησί παρέχοντας πρόσβαση σε οικισμούς και παραλίες. Είναι 
απόλυτα λογικό το μεγαλύτερο μέρος του οδικού να μην είναι ορατό από τους 
οικισμούς. 
 



Πρίνος Πέτρος  © Σελίδα 19 από 38 
 

3.2 Οικισμός Χίος 

 
Χάρτης 4: Ορατότητα οδικού από τον οικισμό Χίου 
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Στο δεύτερο σενάριο της παρούσας διπλωματικής τρέξαμε τον έλεγχο ορατότητας 
από τον οικισμό της Χίου. Όπως ήταν αναμενόμενο το μοναδικό τμήμα του οδικού 
που είναι ορατό είναι αυτό γύρο από τον οικισμό. Τα συνολικά χιλιόμετρα ορατού 
δικτύου περιορίζονται στα 42 και φυσικά τα μισά εξ αυτών είναι άσφαλτος.  
 
 
 

Κατηγορίες Οδικού Ορατό δίκτυο (km) Μη ορατό δίκτυο (km) 

Άσφαλτος 21 583 

Χωμάτινοι βατοί 5 762 

Χωμάτινοι αγροτικοί 13 1.021 

Χωμάτινοι δασικοί 3 257 

Σύνολο 42 2.623 
Πίνακας 3: Κατανομή ορατότητας ανά κατηγορία οδικού από τον οικισμό της Χίου 

 
 
Παρατηρώντας το χάρτη καλύτερα θα περιμέναμε μία μεγαλύτερη οπτική κάλυψη 
στο οδικό γύρο από τη Χίο καθώς πολλά τμήματα εμφανίζονται ως μη ορατά. Σε 
αυτό ίσως συμβάλει η χαμηλή διακριτική ικανότητα του Ψηφιακού Μοντέλου 
Εδάφους που χρησιμοποιήσαμε. 
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Χάρτης 5: Ορατότητα οδικού από τον οικισμό Χίου σε μεγέθυνση 
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3.3 Οικισμός Βροντάδος 

 
Χάρτης 6: Ορατότητα οδικού από τον οικισμό Βροντάδων 
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Ο Οικισμός Βροντάδος βρίσκεται Βόρεια της Χίου και έχει πληθυσμό 5.332 
κατοίκους (απογραφή 2011). Στην ανάλυση ορατότητας παρατηρούμε πολύ μικρή 
ορατότητα του οδικού από τον οικισμό. Σημαντική παρατήρηση είναι ότι το 
μεγαλύτερο μέρος του ορατού οδικού είναι άσφαλτος, τα 12 από τα 16 km.  
 
 
 

Κατηγορίες Οδικού Ορατό δίκτυο (km) Μη ορατό δίκτυο (km) 

Άσφαλτος 12 592 

Χωμάτινοι βατοί 1 766 

Χωμάτινοι αγροτικοί 2 1.032 

Χωμάτινοι δασικοί 1 259 

Σύνολο 16 2.649 
Πίνακας 4: Κατανομή ορατότητας ανά κατηγορία οδικού από τον οικισμό των Βροντάδων 

 
 
Ο Βροντάδος καλύπτεται στα βόρειο - βορειοδυτικά του από ορεινό όγκο που 
περιορίζει την ορατότητα και διαθέτει ελάχιστο οδικό δίκτυο. Οι δυνατότητες 
ορατότητας περιορίζονται προς τα Νότια. 
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Χάρτης 7: Ορατότητα οδικού από τον οικισμό Βροντάδων σε μεγέθυνση 
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3.4 Οικισμός Θυμιανά 

 
Χάρτης 8: Ορατότητα οδικού από τον οικισμό Θυμιανά 
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Ο οικισμός Θυμιανά είναι το τέταρτο σενάριο ελέγχου. Βρίσκεται και αυτός στο 
νοτιοανατολικό τμήμα του νησιού και νοτιότερα της Χίου. Είχε 1.566 κατοίκους στην 
απογραφή του 2011 και περιβάλλεται από αρκετούς οικισμούς του νησιού. Διαθέτει 
τη μεγαλύτερη ορατότητα οδικού που φτάνει τα 129 Km. Μάλιστα η ορατότητα 
είναι υπερδιπλάσια από αυτή της Χίου που είναι ο μεγαλύτερος οικισμός του 
νησιού. Η άσφαλτος και οι αγροτικοί δρόμοι ισοβαθμούν στη πρώτη θέση της 
ορατότητας με 51 km. 
 

 
 

Κατηγορίες Οδικού Ορατό δίκτυο (km) Μη ορατό δίκτυο (km) 

Άσφαλτος 51 553 

Χωμάτινοι βατοί 23 744 

Χωμάτινοι αγροτικοί 51 983 

Χωμάτινοι δασικοί 4 256 

Σύνολο 129 2.536 
Πίνακας 5: Κατανομή ορατότητας ανά κατηγορία οδικού από τον οικισμό Θυμιανά 
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Χάρτης 9: Ορατότητα οδικού από τον οικισμό Θυμιανά σε μεγέθυνση 
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3.5 Οικισμός Πυργί 

 
Χάρτης 10: Ορατότητα οδικού από τον οικισμό Πυργί 
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Το Πυργί είναι ένας μικρός μη παραλιακός οικισμός στο Νότιο τμήμα της Χίου. Ο 
πληθυσμός του οριακά ξεπερνά τους χίλους και δεν διαθέτει γειτονικούς οικισμούς. 
Όπως είναι αναμενόμενο η ορατότητα προς οδικό είναι περιορισμένη και φτάνει τα 
24 km. Το μεγαλύτερο τμήμα του ορατού οδικού είναι αγροτικοί δρόμοι.  
 
 
 

Κατηγορίες Οδικού Ορατό δίκτυο (km) Μη ορατό δίκτυο (km) 

Άσφαλτος 3 601 

Χωμάτινοι βατοί 4 763 

Χωμάτινοι αγροτικοί 15 1019 

Χωμάτινοι δασικοί 2 258 

Σύνολο 24 2.641 
Πίνακας 6: Κατανομή ορατότητας ανά κατηγορία οδικού από τον οικισμό Πυργί 
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Χάρτης 11: Ορατότητα οδικού από τον οικισμό Πυργί σε μεγέθυνση 
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3.6 Οικισμός Νένητα 

 
Χάρτης 12: Ορατότητα οδικού από τον οικισμό Νένητα 
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Ο οικισμός Νένητα είναι το τελευταίο σενάριο ελέγχου μας και βρίσκεται και αυτός 
νοτιοανατολικό τμήμα του νησιού που συναντώνται οι περισσότεροι οικισμοί. Ο 
πληθυσμός του είναι οριακά χίλιοι κάτοικοι και περιβάλλεται από αρκετούς 
οικισμούς. Διαθέτει πολύ καλή ορατότητα προς το οδικό δίκτυο που περιλαμβάνει 
63 km. Τα μισά από αυτά (τα 33) είναι αγροτικοί δρόμοι και ακολουθούν οι βατοί 
χωμάτινοι και η άσφαλτος με 14 και 12 km αντίστοιχα.  
  
 
 

Κατηγορίες Οδικού Ορατό δίκτυο (km) Μη ορατό δίκτυο (km) 

Άσφαλτος 12 592 

Χωμάτινοι βατοί 14 753 

Χωμάτινοι αγροτικοί 33 1.001 

Χωμάτινοι δασικοί 4 256 

Σύνολο 63 2.602 
Πίνακας 7: Κατανομή ορατότητας ανά κατηγορία οδικού από τον οικισμό Νένητα 
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Χάρτης 13: Ορατότητα οδικού από τον οικισμό Νένητα σε μεγέθυνση 
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3.7 Οικισμός Βολισσός 

 
Χάρτης 14: Ορατότητα οδικού από τον οικισμό Βολισσός 
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Ο οικισμός της Βολισσού βρίσκεται στο βορειοδυτικό τμήμα του νησιού. Ο πληθυσμός 
του είναι 222 κάτοικοι το 2011. Αν και μικρός οικισμός επιλέξαμε να τον 
συμπεριλάβουμε στην έρευνά μας καθώς είναι ο μεγαλύτερος οικισμός στο βόρειο 
τμήμα του νησιού όπου δεν απαντώνται μεγάλοι οικισμοί. Κατά την έρευνα ορατότητας 
παρατηρήσαμε ότι η Βολισσός βλέπει περίπου 33 km εκ των οποίων τα 12 είναι 
αγροτικοί δρόμοι. Στο αυτό το σημείο πρέπει να αναφέρουμε ότι μέρος του ορατού 
οδικού δικτύου βρίσκεται κοντά στον οικισμό Σιδηρούντα καθώς και στο νοτιοδυτικό 
τμήμα του νησιού κοντά στην Ελάτα. Στις δύο αυτές περιπτώσεις η ορατότητά 
προκύπτει μέσω θαλάσσης λόγο του κόλπου. Στο σημείο αυτό πρέπει να αναφέρουμε 
ότι ο αλγόριθμος του ελέγχου ορατότητας δεν διαθέτει περιορισμό απόστασης. 
Μετρώντας της απόσταση της Βολισσού από τα παράλια της Ελάτης παρατηρούμε ότι 
βρίσκονται 20 km μακριά. Η απόσταση αυτή είναι πολύ μεγάλη οπότε πρακτικά δεν 
τίθεται θέμα ορατότητας του εκεί οδικού. Ίσως σε μεταγενέστερες έρευνες να πρέπει ο 
έλεγχος ορατότητας να γίνεται με χιλιομετρικό όριο. 

 
 
 
 

Κατηγορίες Οδικού Ορατό δίκτυο (km) Μη ορατό δίκτυο (km) 

Άσφαλτος 7 597 

Χωμάτινοι βατοί 8 759 

Χωμάτινοι αγροτικοί 12 1.022 

Χωμάτινοι δασικοί 6 254 

Σύνολο 33 2.614 
Πίνακας 8: Κατανομή ορατότητας ανά κατηγορία οδικού από τον οικισμό Βολισσός 
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Χάρτης 15: Ορατότητα οδικού από τον οικισμό Βολισσός σε μεγέθυνση 
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4 ΣΥΜΠΕΡΑΣΜΑΤΑ 
 
 
Από την ανάλυση των παραπάνω αποτελεσμάτων μπορούμε να βγάλουμε κάποια 
συμπεράσματα. Η ορατότητα του οδικού δικτύου από τους οικισμούς του Νησιού 
είναι πολύ χαμηλή. Το οδικό γενικά δεν επηρεάζει την εικόνα και δεν αλλοιώνει το 
τοπίο. Ακόμη και στην πρώτη ανάλυση όπου χρησιμοποιήθηκαν όλοι οι οικισμοί το 
μισό οδικό δίκτυο δεν ήταν ορατό. Αν σε αυτό προσθέσουμε ότι μεγάλο μέρος του 
ορατού οδικού είναι εντός οικισμών η παραπάνω πρόταση ενισχύεται. Οι κάτοικοι 
και οι τουρίστες του νησιού μπορούν να απολαμβάνουν μεγάλο μέρος του τοπίου 
χωρίς να διακόπτεται από δρόμους.  
 
Η παραπάνω ανάλυση μας δίνει τη δυνατότητα να προτείνουμε περιοχές του 
οδικού που είναι ή δεν είναι ορατές για την εκμετάλλευσή τους. Για παράδειγμα 
ένα ξενοδοχείο που επιθυμεί να είναι ορατό μπορεί να επιλέξει ως περιοχή 
επένδυσης σε τμήμα του οδικού που είναι ορατό ενώ μία επένδυση κτηνοτροφίας 
μπορεί να επιλέξει τμήμα μη ορατό. 
 
Τέτοιου είδους μελέτες θα πρέπει να λαμβάνονται υπόψη από τις τοπικές αρχές και 
τις αρμόδιες υπηρεσίες για την έκδοση σχετικών αδειών. Η πολεοδομία για 
παράδειγμα θα έπρεπε να βάζει όρια στους συντελεστές δόμησης και στο ύψος των 
κτηρίων ανάλογα με τον βαθμού που αυτά επηρεάζουν την ορατότητα του τοπίου.  
Τέτοια κριτήρια εφαρμόζονται ήδη στον αυστηρότερο βαθμό ώστε να μην 
επηρεάζεται η γραφικότητα ενός τόπου. Θα μπορούσαν όμως να εξαιρούν κάποιες 
περιοχές οι οποίες δεν είναι ορατές ώστε να επιτρέψουν και άλλους οικονομικούς 
κλάδους όπως η βιομηχανία να αναπτυχθούν παράλληλα χωρίς να επηρεάζουν το 
τουρισμό.  
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